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Popis kratica 

PKB  protein kinaza B  (engl. protein kinase B) 

DAG  diacilglicerol  

ER1  estrogen receptor 1   

GDM  gestacijski dijabetes melitus (engl. gestational diabetes mellitus) 

GLUT  prijenosnik glukoze (engl. glucose transporter) 

GP  glikogen fosfataza (engl. glycogen phosphatase) 

GS  glikogen sintetaza  

GSK-3β glikogen sintaza kinaza-3β (engl. glycogen synthase kinase-3β) 

HCl  klorovodična kiselina 

HFHSD hrana bogata mastima i šećerima (engl. high fat high sugar diet) 

HK  heksokinaza (engl. hexokinase) 

IGF-1  inzulinu sličan faktor rasta 1 (engl. insulin-like growth factor 1) 

IP3  inozitol-trifosfat (engl. inositol triphosphate) 

IRS-1  supstrat inzulinskog receptora 1 (engl. insulin receptor substrate 1) 

PAS  bojanje perjodnom kiselinom i Schiffovim reagensom (engl. Periodic acid– 

                      Schiff) 

PI3K  fosfatidilinozitol-3-kinaza (engl. phosphoinositide 3-kinases) 

PIP2  fosfatidilinozitol (4,5)-bisfosfat (engl. phosphatidylinositol 4,5-bisphosphate) 

PKC  protein kinaza C (engl. protein kinase C) 

SD  standardna hrana (engl. standard diet) 

 DM2  dijabetes melitus tip 2 
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1. UVOD 

 

1.1. Glikogen 

 

Glukoza u stanicu ulazi difuzijom kroz jedan od 14 prijenosnika glukoze (obitelj gena Slc2a; 

obitelj proteina: GLUT) ili se aktivno transportira u stanice putem simportera Na+/glukoze 

(obitelj gena Sglt). Nakon ulaska, glukoza se fosforilira heksokinazom (HK) ili glukokinazom 

(specifično za jetru) u glukoza-6-fosfat. Zatim se pomoću enzima fosfoglukomutaze-1 prevodi 

u glukoza-1-fosfat. Ukoliko se glukoza pohranjuje u obliku glikogena, glukoza se prevodi u 

UDP-glukozu pomoću enzima UDP-fosforilaze. Glikogen-sintetaza (GS) zatim prenosi 

glukozni ostatak na već postojeću molekulu glikogena preko α-1,4 glikozidnih veza. Enzim za 

grananje glikogena prenosi glukozilne jedinice s kraja jednog lanca na drugi kraj lanca preko 

α-1,6 glikozidne veze (1). Kao rezultat procesa dobije se razgranata struktura glikogena. Dva 

najveća depozita glikogena nalaze se u jetri i mišićima, iako se mogu naći i u drugim perifernim 

tkivima.  

 

1.1.1. Utjecaj steroidnih hormona na glikogen 

 

Metabolizam glikogena u maternici reguliran je steroidnim hormonima jajnika. Ovisno o vrsti 

različiti hormoni stimuliraju odnosno inhibiraju glikogenezu u maternici. Kod ljudi poznato je 

da progesteron potiče glikogenezu, te će se sukladno tome najviše količine glikogena naći 

neposredno poslije ovulacije u sekrecijskom (luteinizirajućem) dijelu menstruacijskog ciklusa. 

Navedeno potvrđuje podatak da je kod zdravih pacijentica koncentracija glikogena u 

endometriju pet do deset puta veća u sekrecijskoj fazi nego u proliferativnoj fazi (2). Kod drugih 

vrsta, kao što su štakori, glikogeneza je stimulirana estrogenom. Endometrijski glikogen doseže 

vrhunac tijekom proestrusa ili estrusa, kada estrogen doseže svoje najviše vrijednosti te se 

smanjuje za dvije trećine u diestrusu. Estradiol potiče proizvodnju inzulinu sličan faktor rasta 

(IGF-1) u stromi maternice, što posljedično potiče nakupljanje glikogena (3). Nadalje, djeluje 

na metabolizam glikogena preko estrogenskog receptora 1 (ER1) te time povećava osjetljivost 

stanice na inzulin. Odnosno, povećava izražaj supstrata inzulinskog receptora-1 (IRS-1), 

fosfatidilinozitol-3-kinaze (PI3K) i protein kinaze B (PKB) u maternici. U slučaju nedovoljne 

rezerve energije, dolazi do odgođenog formiranja decidue te je implatacija otežana (1). 
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Glikogen igra važnu ulogu tijekom rane trudnoće. Od zigote do faze morule, embriji se 

prvenstveno oslanja na laktat i piruvat za dobivanje energije. Poznato je da estrogen može 

inducirati glikogenezu u maternici nakon iscrpljivanja rezervi ugljikohidrata, odnosno tijekom 

gladovanja. Na taj način osigurava stalne zalihe glikogena koji služi kao izvor lako iskoristive 

energije. 

 

1.1.2. Utjecaj inzulina na glikogen 

 

Inzulin djeluje na način da povećava nakupljanje glikogena povećanjem fosforilirane PKB i 

povećanim izražajem GS. U maternici epitelne stanice endometrija nakupljaju glikogen 

nekoliko dana tijekom implantacijskog razdoblja. Nakon uspješne implantacije, epitel 

endometrija održava sintezu glikogena tjednima tijekom embrionalnog razvoja. Majčin inzulin 

potiče sintezu glikogena na način da se veže na inzulinski receptor na epitelnim stanicama 

endometrija, pokrećući signalizaciju putem IRS-1 i PKB proteina. PKB fosforilacijom 

inaktivira glikogen sintazu kinazu-3β (GSK-3β). Kada je GSK-3β inaktivirana, ona više ne 

može fosforilirati GS (4). Inzulin djeluje na način da neizravno aktivira GS inhibicijom GSK-

3β u kanonskom putu (slika 1). Uz to povećava ukupnu razinu proteina GS povećanjem mRNA 

za GS. Na taj način omogućuje stalnu sintezu glikogena, neovisno o nutritivnim i hormonalnim 

fluktuacijama. Gubitak inzulina može aktivirati 5'-adenozin-monofosfat-aktiviranu protein 

kinazu, povećati ekspresiju glikogen-fosfataze (GP) i potaknuti glikogenolizu u endometriju.  

 

Slika 1. Regulacija sinteze glikogena posredovana inzulinom. GS, glikogen sintetaza; GSK-3β, 

glikogen sintaza kinaza-3β; IRS-1, supstrat inzulinskog receptora 1, PDK1, kinaza 1 ovisna o 

fosfoinozitidu; PI3K, fosfatidilinozitol-3-kinaza; PKB, protein kinaza B. Autor slike: Klara 

Balog.  
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1.2. Histologija maternice 

 

Maternica (lat. uterus) je podijeljena u nekoliko slojeva različite strukture i funkcije. 

Najjednostavnija podjela slojeva je na sluznicu (endometrij), mišićni sloj (miometrij) te serozu 

(perimetrij) (slika 2). Sam endometrij podijeljen je u dvije zone: zona basalis i zona 

functionalis. Zona basalis nalazi se uz miometrij, a čini ju sloj vezivnog tkiva, točnije lamina 

proprija, te sadrži početni dio žlijezda maternice. Zona functionalis sadržava ostatak lamine 

proprije, tubulusne žlijezde (lat. glandulae uterinae) i površinski epitel. Epitel koji karakterizira 

potonji sloj je jednoslojni cilindrični epitel, a čine ga stanice s trepetljikama te žljezdane stanice. 

Miometrij predstavlja najdeblji sloj maternice kojeg karakteriziraju snopovi glatkih mišićnih 

stanica odijeljenih vezivnim tkivom. Razlikujemo unutarnji kružni sloj te vanjski uzdužni sloj 

glatkih mišića. Perimetrij predstavlja seroznu ovojnicu koja oblaže vanjsku stranu maternice. 

 

Slika 2. Histološki prikaz presjeka maternice obojene perjodnom kiselinom i Schiffovim 

reagensom. Legenda: E = endometrij, M = miometrij, UM =unutrašnji sloj miometrija, VM = 

vanjski sloj miometrija, P = perimetrij. Autor fotografije: Klara Balog 
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1.3. Metabolizam glikogena u maternici 

 

Nakon ulaska u fibroblaste maternice, glukoza se metabolizira višestrukim putevima kako bi 

podržala decidualizaciju. Decidualizacija je proces sazrijevanja endometrija, njegove pripreme 

za implataciju. Fibroblasti endometrija prelaze u decidualne stanice. Maternica ne izražava 

fosfoenolpiruvat-karboksikinazu i fruktozo-1,6-bisfosfatazu, enzime koji su važan dio puta 

sinteze glukoze iz piruvata (5). Zbog nemogućnosti izražaja navedenih enzima maternica ne 

može proizvoditi glukozu de novo. To bi značilo da maternica svu glukozu dobiva isključivo iz 

cirkulacije. Iz tog razloga, maternica se služi mehanizmom pohrane glukoze u obliku glikogena. 

Glikogen djeluje kao spremnik glukoze te može regulirati metabolizam i izlučivanje glukoze. 

Decidualizacija je proces koji zahtjeva veće količine glukoze te se tu koristi pentoza-fosfatnim 

putem što su ustanovili Frolovo i suradnici 2011. godine (6). Nakon decidualizacije, decidua 

koristi Warburgov efekt sagorijevajući na taj način veliku količinu glukoze putem glikolize. 

Obilježje ovog promijenjenog metabolizma je povećani unos glukoze i fermentacija glukoze u 

laktat. Taj se fenomen opaža čak i u prisutnosti potpuno funkcionalnih mitohondrija. Navedenu 

činjenicu su pak ustanovili Zuo i suradnici 2015. godine (7). 

 

1.4. Mehanizam kontraktilnosti miometrija 

 

Glikogen, kao važan izvor energije u obliku glukoze, bitan je za učinkovitu kontraktilnost 

miometrija tijekom poroda. Sam mehanizam kontrakcije složen je proces koji se ne može 

odvijati bez utroška energije. Neposredno prije poroda razine glikogena rastu kako bi se 

kontrakcije mogle održavati tijekom cijelog poroda. Kontraktilna aktivnost miometrija ovisi o 

promjenama u koncentraciji intracelularnog Ca2+. Ca2+ igra važnu ulogu kao drugi glasnik, te 

sudjeluje u regulaciji brojnih staničnih procesa kao što su oplodnja, sekrecija, proliferacija, 

preuređenje citoskeleta, izražaj gena, te kontrakcija glatkih mišića. Oslobađanje Ca2+ iz 

unutarstaničnih zaliha (endoplazmatske mrežice) i ulazak iz izvanstaničnog prostora, služi za 

aktiviranje biokemijskih puteva koji dovode do premošćivanja aktina i miozina te posljedično 

tome do kontrakcije. Prevladavajući kalcijevi kanali u miocitima su kalcijevi kanali L-tipa. 

Miometrij sadrži i kalcijeve kanale T-tipa koji pokazuju bržu kinetiku te veći kapacitet 

vodljivosti. S druge strane kalcijevi kanali L-tipa su prikladniji za utjecanje Ca2+ tijekom duljeg 

razdoblja. Cijela kaskadna reakcija počinje kada prvi glasnik stupa u interakciju sa specifičnim 

G-protein spregnutim receptorom koji se nalazi na staničnoj membrani. Aktivacijom G-proteina 
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dolazi do stimulacije membranske fosfolipaze Cβ koja hidrolizira fosfatidilinozitol bisfosfat 

(PIP2) u dva druga glasnika: inozitol-trifosfat (IP3) i diacilglicerol (DAG). IP3 stupa u 

interakciju sa specifičnim, inozitol-trifosfat receptorom koji se nalazi u membrani 

endoplazmatske mrežice te dovodi do oslobađanja Ca2+ iz unutarstaničnog skladišta. Sukladno 

tome dolazi do porasta koncentracije intracelularnog Ca2+. Povećanje Ca2+ neophodan je okidač 

za aktivaciju kalmodulina, Ca2+ ovisnog proteina. Kalmodulin veže četiri Ca2+ iona te čini 

kompleks koji aktivira kinazu lakog lanca miozina koja fosforilira miozin, što aktivira 

kontraktilni mehanizam. DAG aktivira izoformu protein-kinaze C (PKC) za koju je poznato da 

ima nekoliko izoenzima u glatkim mišićima čija je uloga specifična za tkivo. Jedan od učinaka 

je poticanje kontrakcije na način da fosforilira kalcijeve kanale L-tipa (9). 

 

1.5. Dijabetes  

 

Šećerna bolest ili dijabetes je kronična bolest koja nastaje kada gušterača ne proizvodi dovoljno 

inzulina ili kada tijelo ne može učinkovito koristiti inzulin koji proizvodi, točnije stanice postaju 

neosjetljive na inzulin. Hrvatski zavod za javno zdravstvo ističe kako se šećerna bolest može 

smatrati globalnom epidemijom. Razlog tome leži u njegovoj prevalenciji u svijetu koja je 

znatno veća nego što se moglo očekivati prije nekoliko desetljeća. Svjetske procjene govore da 

537 milijuna osoba u dobi od 20 do 79 godina živi sa šećernom bolesti. Dok se na razini Europe 

smatra da od šećerne bolesti boluje 61 milijun osoba u dobi od 20 do 79 godina (10). Dijabetes 

mellitus tip 2 (DM2) karakterizira povećanje glukoneogeneze, inzulinske rezistencije i 

poremećaj metabolizma glikogena zbog disfunkcije β-stanica Langerhansovih otočića 

gušterače (početnu predijabetičku hiperinzulinemiju zamjenjuje dijabetička hipoinzulinemija). 

Klinička slika koja ga karakterizira su hipertenzija, dislipidemija i pretilost, te je praćena 

komplikacijama krvožilnog sustava.  

 

1.5.1. Gestacijski dijabetes 

 

Gestacijski dijabetes melitus (GDM) pojam je koji se upotrebljava kada se dijabetes po prvi 

puta dijagnosticira za vrijeme trudnoće. Najčešće se dijagnosticira u 2. tromjesečju trudnoće. 

Nastaje zbog inzulinske rezistencije koja je potencijalno izazvana hormonima posteljice (11). 

Zbog svog svojstva da uzrokuju dijabetes, hormoni posteljice se često nazivaju i dijabetogeni 

hormoni. Među dijabetogene hormone ubrajamo hormon rasta, hormon koji oslobađa 
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kortikotropin, placentalni laktogen (korionski somatomamotropin), prolaktin i progesteron. 

Majčina hiperglikemija uzrokuje povećan prijenos glukoze i fetalnih β-staničnih sekretagoga 

(aminokiselina), što rezultira fetalnom hiperinzulinemijom. Time dolazi do kratkoročnih 

problema kao što je fetalni prekomjerni rast i/ili pretilost, a mogu nastupiti i dugoročni problemi 

koji se očituju kao metaboličke disfunkcije kasnije u životu. Što se tiče rizika za trudnicu, veća 

inzulinska rezistencija i disfunkcija β-stanica prije trudnoće u žena koje razviju GDM 

povećavaju rizik za oboljenje od DM2 kasnije tokom života. Inzulinska signalizacija tijekom 

trudnoće u žena s normalnom tolerancijom glukoze zahtijeva autofosforilaciju tirozina 

inzulinskog receptora u skeletnim mišićima. U slučaju GDM, uz smanjenje IRS-1, smanjena je 

autofosforilacija tirozina u intracelularnoj domeni β-podjedinice inzulinskog receptora, što 

rezultira 25 % nižim unosom glukoze. 

 

1.6. Dijabetes i kontraktilnost miometrija 

 

Dijabetes donosi brojne komplikacije pri porodu kao što su makrosomija, povećani fetalni 

distres te smanjena kontraktilnost miometrija. Fetalni distres je rijetka komplikacija koja se 

obično događa kada fetus ne prima dovoljno kisika. Zbog brojnih komplikacija sve više je 

indicirana primjena carskog reza kod trudnica s dijabetesom. Smanjena kontraktilnost 

maternice za posljedicu ima produljeni porod i neuspješnu indukciju poroda, što je hitna 

indikacija za carski rez. Kod dijabetesa dolazi do smanjenih rezervi glikogena koji služi kao 

najvažniji izvor energije za kontrakcije maternice. Nadalje, dolazi do smanjene ekspresije i 

signalizacije kalcijevih kanala što se također odražava na  smanjenje kontraktilnosti. Al-Qahtani 

i suradnici proveli su studiju u kojoj kao zaključak ističu smanjenu amplitudu i učestalost 

kontrakcije (12). Smanjenjem funkcije ili ekspresije kalcijevih kanala dolazi do smanjenja 

struje Ca2+ te sukladno tom smanjenja intracelularnog kalcija koji je neophodan za uspješnu 

kontraktilnost maternice (8). S druge strane, Smith i suradnici proveli su istraživanje o utjecaju 

kolesterola na miometrij maternice te ustanovili kako povišene razine kolesterola smanjuju 

snagu kontrakcije djelujući na ekspresiju kalcijevih kanala. Afinitet vezanja oksitocina za 

njegov receptor ovisi o količini membranskog kolesterola te zbog toga pretile rodilje smanjeno 

reagiraju na stimulaciju oksitocinom (13). Kolesterol je fiziološki povišen u trudnoći i kao takav 

utječe na razvoj fetusa. Smatra se i da kolesterol pomaže u održavanju „mirovanja“ maternice 

tijekom trudnoće. Ipak, kod pretilih rodilja kolesterol je znatno povišen te sposobnost 

kontrakcije maternice tijekom poroda može biti ugrožena. 
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2. HIPOTEZA 

 

Izlaganje hrani bogatoj mastima i šećerima prije i tijekom trudnoće smanjuje se sposobnost 

nakupljanja glikogena u mišiću maternice Spraguey-Dawley štakorica.
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3. CILJ ISTRAŽIVANJA 

 

Histokemijskom metodom bojanja perjodnom kiselinom i Schiffovim reagensom (PAS) obojati 

tkiva maternice ženki Sprague–Dawley štakora hranjenih hranom bogatom mastima i šećerima 

i standardnom hranom te kvantificirati i usporediti sadržaj postpartalnog glikogena u 

miometriju tih dviju skupina. 
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4. MATERIJALI I METODE 

 

4.3. Ustroj studije 

 

Eksperimentalna studija na animalnom modelu – studija parova.  

 

4.2. Materijali 

 

Studija je napravljena na arhivi tkiva maternica prikupljenih u sklopu studije RECOOP-CMSC 

Senior Scientist (RCSS) Grant 2018-2020 #012: „The role of obesity-induced low-grade 

inflammation in the adipokine signaling in pregnant rat uterus“ koju je odobrilo Mađarsko 

etičko povjerenstvo za pokuse na životinjama na dan 15. kolovoza 2016., br. IV./3071/2016 i 

Etičko povjerenstvo Medicinskog fakulteta Osijek 17. srpnja 2023., klasa: 602-04/23-08/03, 

URBROJ: 2158-61-46-23-130. 

U istraživanje je uključeno deset ženki Sprague-Dawley štakora koje su podijeljene u dvije 

skupine s po 5 životinja. Kontrolnu skupinu činile su Sprague-Dawley ženke hranjene 

standardnom hranom (SD), a eksperimentalnu skupinu činile su ženke hranjene hranom 

bogatom mastima i šećerima (HFHSD) od 3. tjedna života. Nakon šest tjedana hranjenja obje 

skupine su parene te su 22. dana nakon utvrđene trudnoće žrtvovane. Nakon toga prikupljeno 

je tkivo maternice u svrhu istraživanja. Tkivo je prema protokolu fiksirano u formalinu te 

uklopljeno u parafin. 

 

4.3. Metode 

 

4.3.1. Priprema tkiva 

 

Za proučavanje mikroskopske građe, uzorak je prethodno pripremljen kako slijedi: tkivo 

maternice najprije je fiksirano u 4 %-tnoj puferiranoj otopini formaldehida, kako bi se održala 

struktura same maternice. Slijedilo je uklapanje u parafinske blokove. Izrađeni parafinski 

blokovi zatim su se rezali pomoću rotacijskog mikrotoma (Slee, CUT 4060, Nieder-Olm, 

Njemačka) na rezove debljine 5 µm. Dobiveni rezovi smješteni su na predmetno staklo. Slijedio 

je postupak deparafinizacije nakon čega se vršilo histološko bojanje. 
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4.3.2. Bojanje perjodnom kiselinom i Schiffovim reagensom (PAS) 

 

Za dokaz glikogena koristilo se histokemijsko bojanje perjodnom kiselinom i Schiffovim 

reagensom (PAS). Navedeno bojanje se najčešće koristi za prikaz struktura za koje se želi vidjeti 

udio glikogena i ostalih polisaharida, te spojeva kao što su glikoproteini. Polisaharidi se 

dokazuju na način da reagiraju s perjodnom kiselinom, reakcijom oksidacije, te se time 

oslobađaju aldehidne skupine. Zatim se prikazuju bojanjem fuksin-sumpornom kiselinom, tzv. 

Schiffovim reagensom. Fuksin-sumporna kiselina se kemijskim djelovanjem slobodnih 

aldehida mijenja iz bezbojnog u obojeni oblik. PAS reakcija očituje se u obliku crveno – 

ružičaste do boje ciklame u obliku zrnaca u citoplazmi stanice ili u obliku difuznog crveno – 

ružičastog obojenja citoplazme.  Prethodno je pripremljen Schiffov reagens. Odvagani 1 g 

pararozanilin fuksin i 1,9 g natrijev metabisulfit otopljeni su u 100 ml 0,15 M klorovodične 

kiseline (HCl). Kiselinu je bilo potrebno prethodno pripremiti (12 ml koncentrirane HCl dodano 

je u 1000 ml destilirane vode). Nakon toga dodan je svježi aktivni ugljen u količini 500 mg. 

Tako pripremljena otopina čuvala se u tamnoj boci zaštićenoj od svjetlosti. Nakon toga slijedio 

je postupak obrade rezova tkiva maternice. Rezovi tkiva na stakalcu morali su se 

deparafinizirati uporabom ksilola, dva puta po 5 minuta, te je zatim slijedila rehidracija tkiva 

prolaskom kroz alkoholne kupke sa silaznim koncentracijama alkohola. To je postupak u kojem 

se tkivo prvo uranjalo u 100 %-tni etanol dva puta po 5 minuta, zatim u 96 %-tni etanol, 70 %-

tni etanol te destiliranu vodu po 5 minuta.  Oksidacija se vršila 1 %-tnom perjodnom kiselinom 

10 minuta. Nakon toga slijedio je tretman Schiffovim reagensom 10 minuta. Tijekom postupka 

primijenjeno je bojanje Mayerovim hematoksilinom 3 minute kako bi se jezgre obojale plavom 

do ljubičastom bojom. U daljnjem postupku slijedila je dehidracija etanolom s uzlaznim 

koncentracijama (70 – 100 %), čišćenje destiliranom vodom nakon čega je slijedilo sušenje. Za 

kraj, kao postupak izrade trajnih preparata, preparati su prekriveni kanada balzamom i 

pokrovnim stakalcem.  
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4.3.3. Mikroskopiranje i kvantifikacija 

 

Preparati su mikroskopirani svjetlosnim mikroskopom (Carl Zeiss, Axioskop 2 MOT, Jena, 

Njemačka). Slike tkiva uslikane su digitalnim fotoaparatom Olympus DP70 (Olympus DP70, 

Optical Olympus, Japan) spojenim na mikroskop pod ukupnim povećanjem 50×. Dobivene 

fotografije su se koristile za analizu. Kvantifikacija je provedena u računalnom programu 

ImageJ 1.53 k (14) prema sljedećemo protokolu: 

1) Image > Type > 8-bit 

2) Image > Adjust > Brighteness/contrast > Auto 

3) Analyze > Set Measurents  

4) Edit > Selection > Specify (uzeta su tri kvadrata veličine 230x230 piksela za analizu 

unutarnjeg i vanjskog sloja miometrija) 

5) Analyze > Measure > Mean 

Dobivena srednja vrijednost intenziteta sive boje u odabranoj površini (engl. mean) podudarala 

se s intenzitetom obojenja glikogena te je iskorištena za statističku obradu.  

 

4.4. Statistička obrada podataka 

 

Numerički podatci opisani su aritmetičkom sredinom i standardnom devijacijom u slučaju 

raspodjele koja slijedi normalnu, a u ostalim slučajevima medijanom i granicama 

interkvartilnog raspona. Razlike normalno raspodijeljenih numeričkih varijabli između 

nezavisnih skupina testirane su Studentovim t testom, a u slučaju odstupanja od normalne 

raspodjele Mann-Whitneyevim U testom. Sve P vrijednosti su dvostrane. Razina značajnosti 

postavljena je na α = 0,05. Za statističku analizu korišten je program GraphPad Prism, inačica 

9.5.1 (GraphPad Software, Boston, MA, SAD). 
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5. REZULTATI 

 

5.1. Histokemijska analiza glikogena PAS metodom 

 

Histološkim bojanjem tkiva PAS metodom utvrđena je prisutnost glikogena u endometriju i 

miometriju maternica Sprague-Dawley štakorica SD i HFHSD skupine. Pri pregledu preparata 

jasno su se mogli uočiti zasebni unutrašnji i vanjski sloj miometrija u kojima je provedena 

analiza količine glikogena. Kod štakorica hranjenih standardnom hranom, možemo primijetiti 

glikogenske granule obojene karakteristično ljubičastom bojom. Naime, na istoj fotografiji 

možemo uočiti primjer maternice štakorica hranjenih prehranom bogatom mastima i šećerima 

u kojoj primjećujemo oskudnije slojeve maternice, iako možemo primjetiti rezerve glikogena 

(slika 3). 

 

Slika 3. Tkivo maternice obojeno perjodnom kiselinom i Schiffovim reagensom (PAS) u 

svrhu usporedbe količine glikogena u miometriju Sprague-Dawley štakorica na standardnoj 

(SD) ili prehrani bogatoj mastima i šećerima (HFHSD). Kod tkiva maternice HFHSD 

skupine primjećuju se nešto oskudniji slojevi za razliku od tkiva maternice SD skupine. 

Svaka skupina je prikazana u triplikatu kako bi se ilustrirala varijabilnost unutar skupine. 

Ukupno povećanje 50 ×. Autor fotografije: Klara Balog.  
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5.2. Analiza intenziteta obojenja u tkivu miometrija SD i HFHSD skupina 

 

Razina glikogena ispitivana je u miometriju maternice, uključujući unutarnji i vanjski sloj 

miometrija. Svrha je ustanoviti povezanost između nakupljanja glikogena i različitog tipa 

prehrane: standardne (SD) i prehranom s visokim udjelom masti i šećera (HFHSD). 

Prva usporedba temelji se na podatcima dobivenim analizom razine glikogena u unutarnjem 

sloju miometrija štakorica SD i HFHSD skupine. Podatci obje skupine slijedili su normalnu 

distribuciju (Shapiro-Wilkov test, SD: p = 0,416, HFHSD: p = 0,796). Dodatno je rađen 

studentov t test i dobivena p vrijednost iznosila je 0,052. Navedeni statistički podatci ukazuju  

da nema statistički značajne razlike u razini glikogena u unutarnjem sloju miometrija između 

SD i HFHSD skupina. Iako, može se reći da rezultat ima graničnu vrijednost (slika 4). 

Druga usporedba temelji se na podatcima dobivenim analizom razine glikogena u vanjskom 

sloju miometrija štakorica SD i HFHSD skupine. Podatci ove dvije skupine nisu slijedili 

normalnu distribuciju (Shapiro-Wilkov test, SD: p = 0,035, HFHSD: p = 0,21). Skupine su dalje 

uspoređene Mann Whitney testom i dobivena je vrijednost p = 0,016. Navedeni rezultati 

pokazuju statistički značajnu razliku u razini glikogena u vanjskom sloju miometrija između 

pripadnica SD i HFHSD skupine (slika 4).  
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Slika 4: Grafički prikaz relativnog intenziteta obojenja mišića maternice PAS metodom. 

Relativni intenzitet obojenja izražen je u obliku srednje vrijednosti sive boje (engl. mean gray 

value), koja predstavlja zbroj vrijednosti svih piksela podijeljen s ukupnim brojem piksela u 

području od interesa (vrijednost u rasponu od 0 do 255). Stupci predstavljaju aritmetičku 

sredinu, u slučaju unutarnjeg sloja miometrija, ili medijan u slučaju vanjskog sloja miometrija. 

Okomite crte s graničnicima predstavljaju standardnu devijaciju, u slučaju unutarnjeg sloja 

miometrija, te granice interkvartalnog raspona u slučaju vanjskog sloja miometrija, kao mjeru 

odstupanja od srednje vrijednosti. Obojenje je proporcionalno razini nakupljanja glikogena u 

unutarnjem i vanjskom sloju miometrija štakorica hranjenih standardnom prehranom (SD) i 

prehranom bogatom mastima i šećerima (HFHSD). U unutarnjem sloju miometrija između SD 

i HFHSD skupine utvrđena je granična vrijednost značajnosti (p = 0,052). Vanjski sloj 

miometrija HFHSD skupine ima statistički značajno povećan intenzitet bojenja u odnosu na SD 

skupinu (p = 0,016). (* statistička značajnost p < 0,05). UM, unutarnji sloj miometrija; VM, 

vanjski sloj miometrija. 
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6. RASPRAVA 

 

Svrha našeg istraživanja bila je utvrditi dolazi li do smanjivanja zaliha glikogena kod štakorica 

hranjenih prehranom s visokim udjelom masti i šećera (HFHSD). Blagi porast glikogena uočava 

se u vanjskom sloju miometrija što ne ide u prilog našoj hipotezi da je pad glikogena kod DM2 

razlog oslabljenih kontrakcija i otežanog poroda. Našu pretpostavku kako je glikogen važan 

oblik energije tijekom poroda potvrđuje istraživanje Chew i Rinard (1979.) koji su dokazali 

veliki porast glikogena u miometriju gravidnih štakorica prije poroda, te pad glikogena odmah 

nakon poroda. Izvijestili su o povećanim zalihama glikogena kod štakorica od 18. do 22. dana 

trudnoće. Neposredno prije poroda koncentracije glikogena bile su dva puta veće u odnosu na 

koncentracije uočene u proestrusu (15). U ispitivanih štakorica, sekrecija progesterona počinje 

opadati oko 15. dana trudnoće, dok je estrogen nešto niži do 18. dana te nakon toga brzo raste 

do 22. dana trudnoće. Neposredno prije poroda dolazi do pojačanog lučenja estrogena te 

sukladno tome i povećanim nakupljanjem glikogena. Navedene činjenice sugeriraju da se 

glikogen intenzivno troši tijekom poroda te služi kao izvor energije za održavanje kontrakcije 

tijekom poroda. U pozadini povišenih rezervi glikogena stoji estrogen. Naime, estrogen kod 

štakorica počinje rasti od 18.-22. dana trudnoće sve do poroda, a poseban rast bilježi se pred 

porod što je proporcionalno sadržaju glikogena. Relaksin, hormon koji se otpušta neposredno 

prije poroda, a luči ga žuto tijelo i posteljica, djeluje na relaksaciju mišića maternice, mišića 

zdjelice, te sarkoilijakalnih zglobova, te na taj način olakšava prolaz ploda kroz porođajni kanal. 

Uz sve navedeno, utječe na pojačano nakupljanje glikogena što su uočili Kroc i suradnici 1959. 

godine (16). Nakon poroda zalihe glikogena su iscrpljene te padaju na vrijednosti približno 

jednake koncentracijama uočenim 20. dana trudnoće. Naime, tijekom poroda kada dolazi do 

jakih kontrakcija maternice, sukladno tome dolazi i do smanjenog protoka krvi u maternicu. 

Tada rezerve glikogena predstavljaju izrazitu važnost u održavanju kontraktilnosti maternice 

tijekom poroda. Sve navedeno ide u prilog činjenici da zalihe glikogena služe kao važan izvor 

energije za maternicu tijekom poroda. Zanimljiva je dokazana činjenica koju su ustanovili 

Hautakangas i suradnici (2022.) kako su kontrakcije pretilih rodilja jednako jake kao i 

kontrakcije mršavih rodilja, iako je poznato da pretile rodilje često imaju indikaciju za carski 

rez. Razlozi se prepisuju svojstvu cervikalnog kanala i njegove sposobnosti širenja. Naime, 

cervikalni kanal biva nepopustljiv i čvrst te napetost stijenke maternice raste čime raste i 

intrauterini tlak. Pretile rodilje kao komplikaciju poroda mogu imati nemogućnost izvođenja 
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porođaja vaginalnim putem i dolaženja do stadija aktivnog poroda (17). Proučavanje 

nakupljanja glikogena u maternici najviše je bilo usmjereno na proučavanje djelovanja spolnih 

hormona. Smatralo se da estrogen kod pojedinih vrsta, kao što su štakori, utječe na pojačano 

nakupljanje glikogena u svim slojevima maternice, dok kod ljudi nakupljanje uzrokuje 

progesteron (5). Ustanovljeno je kako hormoni hipofize i kore nadbubrežne žlijezde nemaju 

učinak na pojačano odlaganje glikogena u maternici. Učinak prekomjerne prehrane na 

skladištenje glukoze u obliku glikogena proučavali su Mott i suradnici (1986.). Ispitanice su na 

dva tjedna izložili prekomjernoj prehrani uz 65% veći unos kalorija od normalnog unosa. 

Rezultati su pokazali kako kratkotrajno izlaganje prekomjernoj prehrani uzrokuje smanjenje 

djelovanja inzulina na skladištenje i odlaganje glukoze. U uvodu je objašnjeno kako inzulin 

djeluje na pojačano nakupljanje glikogena. Navedeno smanjenje skladištenja glikogena 

koreliralo je s visokim koncentracijama inzulina u krvi. Zabilježena je i smanjena aktivnost 

glikogen sintetaze koja je pridonijela učinku prekomjerne prehrane na skladištenje glukoze 

(18). Bo i Atkinson (1962.) provedeli su istraživanje na jedinkama štakora kastrata tretiranih 

hormonima jajnika. Oni su opazili granule glikogena u oba mišićna sloja maternice, iako je 

puno veće nakupljanje glikogena zapaženo u vanjskom (uzdužnom) mišićnom sloju (19). 

Istraživanje se podudara s našim rezultatima i opažanjem statistički značajnog povećanja 

glikogena u vanjskom sloju miometrija. Godinu kasnije proveli su istraživanje koje se temelji 

na analizi zaliha glikogena u maternici štakorica koje su povrgnuti režimu izgladnjivanja. 

Poznato je kako metabolizam ugljikohidrata reguliraju gušterača, prednji režanj hipofize i kora 

nadbubrežne žlijezde. Istraživanjem se dokazalo kako kod hipofizektomiranih i 

adrenalektomiranih štakorica, pod utjecajem estrogena, dolazi do sinteze i nakupljanja 

glikogena u tkivu maternice. Djelovanje estrogena na maternicu neovisno je o endokrinim 

hormonima navedenih organa, ali može se reći da je analogno ulozi koju igraju hormoni 

potonjih organa u nakupljanju glikogena u jetri i skeletnim mišićima. Cilj je bio utvrditi može 

li estrogen inducirati glikogenezu i nakon iscrpljivanja rezervi glikogena. Došlo se do zaključka 

kako se zalihe glikogena smanjuju u jetri i skeletnim mišićima tijekom gladovanja, ali u 

miometriju maternice pod stimulacijom velikih količina estrogena ne dolazi do smanjenja 

zaliha glikogena (20). Trudnoća je stanje u kojem dolazi do velikog porasta hormona estrogena 

i progesterona. Zaključno tome, estrogen stimulira nakupljanje glikogena u količinama koje se 

mogu usporediti s zalihama glikogena u dobro uhranjenih životinja. Sadržaj glikogena u 

miometriju štakora varira sa stanjem kontraktilnosti. He i Kelley (2004.) zabilježili su 

smanjenje mišićnog glikogena za približno 20 % u DM2 ispitanika u usporedbi s mršavim 

nedijabetičarima. Rezultati su korelirali s hiperglikemijom natašte. Iako je došlo do smanjenja 
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zaliha glikogena za 20 %, ovi rezultati ne pokazuju statistički značajno smanjenje uz činjenicu 

da je istaknut nedostatak u aktivnosti GS (21). U svojem istraživanju napominju kako je moguće 

da uopće ne dođe do značajnog smanjenja zaliha glikogena u miometriju kod ispitanika s 

dijabetesom. S druge strane, postoje istraživanja (22, 23) koja su zabilježila povišene razine 

glikogena u masnom tkivu i tkivu bubrega kod osoba oboljelih od DM2. Iako, isto tako ističu 

kako za jetru i skeletne mišiće nisu karakteristične visoke razine glikogena kod DM2 (23). Meza 

i suradnici (2017.) proveli su istraživanje u kojem su skupinu ispitanika hranili „zapadnjačkom“ 

prehranom s visokim udjelom masti tijekom 9 tjedana, te ih nakon toga još 6 tjedana nastavili 

hraniti „zapadnjačkom“ prehranom ili standardnom prehranom. Zabilježeno je smanjenje 

razine glikogena u skeletnim mišićima kod ispitanika hranjenih prehranom s visokim udjelom 

masti. Napominju kako je 9 tjedana prehrane bogate mastima bilo dovoljno kako bi se kod 

ispitanika stvorila inzulinska rezistencija. (24). Štakorice u našem istraživanju su također 

hranjene 9 tjedana. Točnije, hranjeni su 6 tjedana te tijekom trudnoće koja je trajala 22 dana. 

No, kod naših ispitanika HFHSD skupine nije došlo do smanjenih zaliha glikogena. Iz razloga 

što ovo je istraživanje provedeno na skeletnim mišićima, ova činjenica nas može navesti na 

razmišljanje kako prehrana nije jedini aspekti koji utječe na zalihe glikogena već bi potencijalno 

objašnjenje moglo biti da glatki mišići u trudnoći, a možda i bez trudnoće, drugačije troši 

glikogen od skeletnih mišića. Još 1963. Bueding i suradnici su otkrili da se fosforilaza razlikuje 

u skeletnom i glatkom mišiću, te da je aktivnost fosforilaze 10 puta veća od aktivnosti 

fosforilaze u glatkim mišićima (25). Kontrakcija glatkih mišića prvenstveno je regulirana 

reverzibilnom fosforilacijom miozina koja je potaknuta povećanjem slobodnog Ca2+ u 

sarkoplazmi. Kontrakcije glatkih mišića regulirane su i drugim mehanizmima, a jedan od njih 

je i regulacija kalponinom, proteinom koji se za aktin veže velikim afinitetom. On omogućuje 

očuvanje energije kod produljene kontrakcije (26). Zaključno tome, glatki mišići iako imaju 

manji energetski skup adenozin trifosfata i kreatin fosfata u odnosu na skeletne mišiće, zbog 

smanjene aktivnosti fosforilaze ne dolazi do brzog trošenja glikogena kao što je slučaj kod 

skeletnih mišića. Navedeno ide u prilog očuvanju zaliha glikogena u vanjskom sloju 

miometrija. 

Razlika u količini glikogena između ispitivanih skupina nije velika, ali je ipak statistički 

značajna, a tome u prilog idu prethodna istraživanja koja su ustanovila da maternica trudnih 

jedinki ima mehanizam čuvanja zalihe glikogena koji nije ovisan o režimu prehrane. Razlog 

može biti u činjenici da je estrogen učinkovit stimulans glikogeneze čak i kada su iscrpljene 

rezerve glikogena. Kao drugo moguće objašnjenje navodi se početna hiperinzulinemija koja 
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korelira s povišenim razinama glukoze unesenih hranom, a kao rezultat dobijemo povišene 

razine glikogena koje su nešto više izražene u vanjskom sloju miometrija. Možemo 

pretpostaviti da ukoliko bi prehrana s visokim udjelom masti i šećera potrajala dulje, tek tada 

bi došlo bi do potpune inzulinske rezistencije i smanjenja razine glikogena. U svakom slučaju, 

za potvrdu inzulinske rezistencije maternice nije dovoljna kvantifikacija glikogena već se 

istraživanje mora upotpuniti ispitivanjem aktivacije signalnog puta nakon stimulacije inzulinom 

ili faktorom rasta 1 sličnog inzulinu.  
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7. ZAKLJUČAK 

 

Histokemijskom metodom bojanja perjodnom kiselinom i Schiffovim reagensom vizualizirane 

su granule glikogena u vanjskom i unutarnjem sloju miometrija ženki štakora hranjenih 

standardnom prehranom i onih koji su hranjeni prehranom bogatom mastima i šećerima te je 

utvrđena značajna razlika među skupinama u vanjskom sloju miometrija: skupina životinja 

hranjenih hranom bogatom mastima i šećerima ima povećane zalihe glikogena u odnosu na 

skupinu hranjenu standardnom prehranom. 
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8. SAŽETAK 

 

Ciljevi: Ciljevi ovog istraživanja bili su histokemijskom metodom bojanja perjodnom 

kiselinom i Schiffovim reagensom (PAS) obojati tkiva maternice štakorica hranjenih hranom 

bogatom mastima i šećerima (HFHSD) te standardnom hranom (SD) te kvantificirati i 

usporediti sadržaj postpartalnog glikogena u miometriju obje skupine ženki Sprague-Dawley 

štakora.  

Ustroj studije: Eksperimentalna studija na animalnom modelu – studija parova.  

Materijali i metode: Studija je napravljena na arhivi tkiva maternica prikupljenih u sklopu 

studije RECOOP-CMSC Senior Scientist (RCSS) Grant 2018-2020 #012: „The role of obesity-

induced low-grade inflammation in the adipokine signaling in pregnant rat uterus“. Deset ženki 

Sprague-Dawley štakora podjeljene su u dvije skupine. Kontrolnu skupinu činile su SD 

Sprague-Dawley ženke, a eksperimentalnu skupinu HFHSD ženke koje su ovu prehranu 

dobivale od 3. tjedna života. Prisutnost glikogenskih granula analizirana je PAS bojenjem. 

Tkivo maternice najprije je fiksirano u 4 %-tnoj puferiranoj otopini formaldehida, nakon čega 

je slijedilo uklapanje u parafinske blokove. Dobiveni rezovi debljine 5 µm, nakon 

deparafinizacije, obojeni su PAS metodom. Slijedila je analiza fotografija i usporedba 

statističkih rezultata. 

Rezultati: U vanjskom sloju miometrija između SD i HFHSD skupina utvrđena je statistički 

značajna razlika u razinama glikogena (p = 0,016), za razliku od unutarnjeg sloja miometrija 

gdje je utvrđena granična vrijednost.  

Zaključak: Povišene razine glikogena u vanjskom miometriju kod pripadnica HFHSD skupine 

u usporedbi s pripadnicama SD skupine pokazuju da je ovaj sloj maternice osjetljiviji na režim 

prehrane od unutrašnjeg sloja.  

Ključne riječi: glikogen, maternica, miometrij, gestacijski dijabetes 
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9. SUMMARY 

 

Postpartum glycogen content in the myometrium of female Sprague-Dawley rats fed a 

diet rich in fats and sugars 

Objectives: The objectives of this research were to use the histochemical method of periodic 

acid Schiff staining (PAS) to stain the uterine tissues of rats fed a high-fat and high-sugar diet 

(HFHSD) and a standard diet (SD), and to quantify and compare the content of postpartum 

glycogen in the myometrium of both groups of Sprague- Dawley rats. 

Study desing: Experimental research on an animal model – the case-control study.  

Materials and methods: The study was made on the archive of maternal tissues collected as 

part of the study RECOOP-CMSC Senior Scientist (RCSS) Grant 2018-2020 #012: "The role 

of obesity-induced low-grade inflammation in the adipokine signaling in pregnant rat uterus". 

Ten female Sprague-Dawley rats were divided into two groups. The control group consisted of 

SD Sprague-Dawley women, and the experimental group consisted of HFHSD women who 

received this diet from the 3rd week of life. The presence of glycogen granules was analyzed 

by PAS staining. The maternity tissue was first fixed in a 4% buffered formaldehyde solution, 

followed by embedding in paraffin blocks. The 5 µm thick sections obtained, after 

deparaffinization, were stained with the PAS method. This was followed by photo analysis and 

comparison of statistical results. 

Results: In the outer layer of the myometrium between the SD and HFHSD groups, a 

statistically significant difference in glycogen levels was found (p = 0.016), in contrast to the 

inner layer of the myometrium, where the limit value was determined. 

Conclusion: Increased levels of glycogen in the outer myometrium in the HFHSD group 

compared to the SD group show that this layer of the uterus is more sensitive to the diet than 

the inner layer. 

Key words: glycogen, uterus, myometrium, gestational diabetes
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